
Welcome to IMSI Capture
Welcome to IMSI Capture, a program for capturing images, animations, and entire web sites. Click the topics below to find out 
how to use the program.

What is IMSI Capture?

Capturing a single image 

Using Automatic Capture 

Capturing motion 

Capturing a web site 

Setup Options 

Using the IMSI Capture Control Center 



What is IMSI Capture?
IMSI Capture is a program that allows you to capture images, animations, and web pages. After you set up the options you want,
you can minimize or close IMSI Capture and use hotkeys to start and stop the capture process.

Single image Capture
IMSI Capture allows you to take a snapshot of your entire screen or any area of your screen that you specify. You can store the 
image in the Windows Clipboard and insert it in another application, or save the image as a bitmap file. For more information see
Capturing a single image.

Automatic Capture
Automatic Capture uses a timer to automatically capture images at intervals that you specify. This is useful if you are 
documenting a series of steps and want a capture of each step. For example, if you are documenting a series of steps, you 
might set the Interval to 30 seconds to allow yourself time to change the screen before each capture. For more information see 
Automatically capturing images at a specified time interval.

Motion Capture
This option captures a series of images and creates a Video for Windows (AVI) file. You can use it to capture motion on your 
screen. For example, if you want to document a procedure on your screen that involves moving the cursor and clicking menus, 
you can use Motion Capture to create a video file. By adjusting the frame rate of the capture, you can control the smoothness 
and the size of the video file you create. For more information see Capturing motion.

Web Capture
IMSI Capture allows you to capture web sites. You set the number of levels of hyperlinks you want to download and IMSI 
Capture will place the entire contents of a web site on your computer. You can capture web sites during off-hours when the 
phone line isn't needed, then view the contents of the web site off-line without any waiting. For more information see Capturing a 
web site.



Capturing a single image
To capture a single image you first set up the options you want in the IMSI Capture Setup dialog, then you initiate the capture by 
clicking the Capture button or by pressing the hotkeys.

The settings in the IMSI Capture Setup dialog allow you to specify what kind of capture will be performed and where the 
captured image will be placed.

Once these options are set, you can minimize the IMSI Capture Setup dialog box and take a screen capture using the hotkeys at
any time. If the Control Center is running you can close the IMSI Capture Setup dialog box and initiate a capture using the 
Control Center or the hotkeys.

To capture a single image
1 In the IMSI Capture Setup dialog, select the Image button .

2 In the Capture To section, click one or more of the following destinations for your captured object:
File 
Clipboard 
Printer 

3 If you selected File in the previous step, click either manual or automatic to specify how the file will be named and then select 
a file type . In the File Name box, type the full path and file name for the captured image. If you are not sure of the path or file 
type you want to use, click Browse.

4 Set any of the other options in the IMSI Capture Setup dialog. For information about the setup options, use context-sensitive 
help, or see Settings for Single Image Capture.

5 In the Capture Method box , select the method you want to use.

For further instructions
Click the capture method that you selected.

 Screen
 Windows
 Area (Area-rect, Area-ellipse, Area-freeshape, or Area-star)



Capturing an Entire Screen
This method captures the entire screen. When you initiate the capture, there are no further prompts and an image of the entire 
screen is captured using the settings you specified.

To capture a screen
1 Make sure the Capture Method box , is set to Screen.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI Capture 
Setup dialog (Ctrl+Shift+C by default). The entire screen is captured.



Capturing a Window
This method captures a window that you select. A window can be an entire application window, a dialog box, a section within a 
dialog box, a button, or a toolbar. After you initiate the capture, as you move the cursor over the screen, available windows are 
highlighted and you can click the window you want to capture.

To capture a window
1 Make sure the Capture Method box , is set to Window.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI Capture 
Setup dialog (Ctrl+Shift+C by default).

4 The cursor changes to a pointing hand and as you move it over available windows they become highlighted. When the 
window you want to capture is highlighted, click to select it.



Capturing an Area
This method allows you to outline the area that you want to capture. You can specify one of four shapes for the capture area—
rectangle, ellipse, freeshape, and star. After you initiate the capture, the cursor becomes a scissors icon and you can click and 
drag to define the area to capture.

To capture an area
1 In the Capture Method box , select one of the following options:

Area-Rect, to capture a rectangular area of the screen
Area-Ellipse, to capture an elliptical area of the screen
Area-Freeshape, to capture an area defined by a freehand line that you draw
Area-Star, to capture an area within a star shape.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI Capture 
Setup dialog (Ctrl+Shift+C by default).

4 The cursor changes to a scissors icon and you can click and drag to define the area to be included in the capture.



Setup Options: Overview
The IMSI Capture Setup dialog box, contains the main interface for IMSI Capture. In this dialog box, you select the type of 
capture you want to perform, and select all the settings that will be applied to the capture. The options that are available in the 
dialog box change depending upon the type of capture you choose. For information on the settings see the following topics:

Settings for Single Image Capture 

Settings for Automatic Capture 

Settings for Motion Capture 

Settings for Web Capture 



Settings for Single Image Capture

 The following settings are available in the main part of the IMSI Capture Setup dialog when the Single Frame Capture button is 
selected

Capture Method 

Hotkeys 

Delay 

Capture to:

File 
Clipboard 
Printer 

New file selection:

Manual 
Automatic 

File type 

File name 

Options 

Close 

Capture Now 

 Click here for information on other options.



Settings for Automatic Capture

 The following settings are available in the main part of the IMSI Capture Setup dialog when the Automatic Capture button is 
selected

Capture Method 

Hotkeys 

Delay 

Interval:

Hr 
Mn 
Sc 

Maximum number of files, Limit 

File type 

File name/File prefix 

Options 

Close 

Capture Now 

 Click here for information on other options.



Settings for Motion Capture

 The following settings are available in the main part of the IMSI Capture Setup dialog when the Motion Capture button is 
selected

Capture Method 

Hotkeys 

Delay 

AVI options:

Frame rate 
Max time 
Max size 

New file selection:

Manual 
Automatic 

File type 

Compress 

Setup 

File name 

Options 

Close 

Capture Now 

 Click here for information on other options.



Settings for Web Capture

 The following settings are available in the main part of the IMSI Capture Setup dialog when the Web Capture button is selected

Hotkeys 

Delay 

Name 

Sites 

Location 

Start URL 

Filters 
WWW Scope:

Unlimited 
Start Website 
Start Directory 

Options 

Close 

Capture Now 

 Click here for information on other options.



Other Options

The advanced options are available when you extend the IMSI Capture Setup dialog by clicking the Options button. The options 
that are available will change depending on your selections in the top part of the IMSI Capture Setup dilaog.

Image Features:

Show Cursor 
Border 
Grayscale 

Audible Alert:

When capture started 
When capture finished 
Timer before capture 

Existing Files:

Skip 
Overwrite 
Use query 

Advanced Options:

Autoscroll (see the note below)
Annotation 
Remove Equal Frames 

Preview 

Load on startup 

Close 

Capture Now 

Note

· The Autoscroll feature might work incorrectly with some programs. This happens because some programs use custom 
methods for dealing with incoming scrolling messages. Therefore, the Autoscroll feature is sometimes unable to correctly 
connect parts of a captured image.



Using Automatic Capture
Automatic Capture uses a timer to automatically capture images at intervals that you specify. You can stop the captures at any 
time by clicking the Capture Now button , or by pressing the same Hotkey combination that you used to start the capture.

To use Automatic Capture
1 In the IMSI Capture Setup dialog, select the Auto button. 

2 Set the time interval that you want between captures using the Hr, Mn, and Sc boxes. For example, to have an automatic 
capture made every 1 minute, set Hr to 0, Mn to 1, and Sc to 0.

3 Set any options you want for the capture. For more information use context-sensitive help, or see Settings for Automatic 
Capture.

4 In the Maximum number of files box, select the maximum number of files that can be generated with the current file name 
prefix. When the maximum number of files is reached, a message will notify you.

5 In the File Prefix box, type the full path and the first part of the file name for the captured images. If you are not sure of the 
path you want to use, click Browse.

6 In the Capture Method box , select the method you want to use.

For further instructions
Click the capture method that you selected.

 Screen
 Windows
 Area (Area-Rect, Area-Ellipse, Area-Freeshape, Area-Star)



Automatically Capturing Entire Screens
This method captures the entire screen. When you initiate the capture, there are no further prompts and an image of the entire 
screen is captured using the settings you specified. The full screen is captured at the time interval you specified until the 
maximum number of files is reached or you stop the capture.

To automatically capture entire screens
1 Make sure the Capture Method box , is set to Screen.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the first image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI 
Capture Setup dialog (Ctrl+Shift+C by default). The entire screen is captured repeatedly at the time interval you specified. The
capture process ends when the maximum number of files is reached or you stop the capture.

Note

· You can stop an automatic capture at any time by clicking the Capture Now button, or by pressing the same Hotkey 
combination that you used to start the capture.



Automatically Capturing a Window
This method repeatedly captures an area of your screen defined by a window that you select. A window can be an entire 
application window, a dialog box, a section within a dialog box, a button, or a toolbar. After you initiate the capture, as you move 
the cursor over the screen, available windows are highlighted and you can click the window you want to capture. All subsequent 
captures in the automatic capture process will be within the area defined by the window you selected.

To capture a window
1 Make sure the Capture Method box , is set to Window.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the first image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI 
Capture Setup dialog (Ctrl+Shift+C by default).

4 The cursor changes to a pointing hand and as you move it over available windows they become highlighted. When the 
window you want to capture is highlighted, click to select it. The window is captured and captures continue to occur in the area
defined by the window you selected. Even if you change the screen, and the area no longer represents a discrete window, the 
area of your screen defined by the original window you selected is captured.

Note

· You can stop an automatic capture at any time by clicking the Capture Now button, or by pressing the same Hotkey 
combination that you used to start the capture.



Automatically Capturing an Area
This method allows you to outline the area that you want to capture. You can specify one of four shapes for the capture area—
rectangle, ellipse, freeshape, and star. After you initiate the capture, the cursor becomes a scissors icon and you can click and 
drag to define the area to capture. The image within the area that you define is repeatedly captured until the maximum number of
files is reached or you stop the capture.

To capture an area
1 In the Capture Method box , select one of the following options:

Area-Rect, to capture a rectangular area of the screen
Area-Ellipse, to capture an elliptical area of the screen
Area-Freeshape, to capture an area defined by a freehand line that you draw
Area-Star, to capture an area within a star shape.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI Capture 
Setup dialog (Ctrl+Shift+C by default).

4 The cursor changes to a scissors icon and you can click and drag to define the area to be included in the capture. Captures 
continue to occur in the area you defined until the maximum number of files is reached, or you stop the capture.

Note

· You can stop an automatic capture at any time by clicking the Capture Now button, or by pressing the same Hotkey 
combination that you used to start the capture.



Capturing motion
The Motion Capture option allows you to capture a series of images as an AVI file.

To use Motion Capture
1 In the IMSI Capture Setup dialog, select the Motion button. 

2 In the AVI options section of the dialog, enter a Frame Rate . A higher frame rate results in a smoother animation but results in 
a larger AVI file.

3 In the Max. time and Max size boxes, set a maximum time and size for the AVI file. If you set these boxes to zero, the frame 
captures continue until you stop the capture.

4 In the New File Selection section, click either manual or automatic to specify how the file will be named. 

5 In the File Name box, type the full path and file name for the AVI file you will generate. If you are not sure of the path or file 
type you want to use, click Browse.

6 If you want the file to be compressed as it is generated, select the Compress check box. It is recommend that you use 
compression, since AVI files can be very large.

7 Set any options you want for the capture. For more information use context-sensitive help, or see Settings for Animated 
Motion.

8 In the Capture Method box , select the method you want to use.

For further instructions
Click the capture method that you selected.

 Screen
 Windows
 Area (Area-Rect, Area, Ellipse, Area-Freeshape, or Area-Star)

Note

· The system media player (mplayer.exe) on some hardware fails to play AVI files created with compression. That is why the 
Preview option is disabled if the Compress option is turned on. To play the file use another media player such as mplayer2.exe
from Microsoft.



Creating an AVI file from a Screen
This method captures images from the entire screen and creates an AVI file. When you initiate the capture, there are no further 
prompts and an image of the entire screen is captured using the settings you specified. The full screen is captured at the frame 
rate you specified until the maximum time, or the maximum file size you specified is reached. You can stop the capture at any 
time by pressing the same hotkey combination used to initiate the capture.

To create an AVI file from an entire screen
1 Make sure the Capture Method box , is set to Screen.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the starting image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI 
Capture Setup dialog (Ctrl+Shift+C by default). The entire screen is captured repeatedly at the Frame Rate you specified. 
Press the hotkeys again to end the capture.

Note

You can choose to remove consecutive frames in which the image is the same by selecting the Remove Equal Frames check 
box in the lower part of the IMSI Capture dialog (accessed by clicking the Options button. ). When this option is selected, only 
frames that have changed from the previous frame are included in the AVI file. This reduces the size of the AVI file without 
affecting the appearance of the animation



Creating an AVI File from a Window
This method repeatedly captures movement within an area of your screen defined by a window that you select. A window can be 
an entire application window, a dialog box, a section within a dialog box, a button, or a toolbar. After you initiate the capture, as 
you move the cursor over the screen, available windows are highlighted and you can click the window you want to capture. All 
frames in the AVI file will be within the area defined by the window you selected.

To capture motion within a window
1 Make sure the Capture Method box , is set to Window.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the starting image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI 
Capture Setup dialog (Ctrl+Shift+C by default).

4 The cursor changes to a pointing hand and as you move it over available windows they become highlighted. When the 
window you want to capture is highlighted, click to select it. The window is captured at the Frame Rate you specified in the 
IMSI Capture Setup dialog and used to generate an AVI file. Even if you change the screen and the area no longer represents 
a discrete window, the area of your screen defined by the window you selected is captured in the frames.

Note

You can choose to remove consecutive frames in which the image is the same by selecting the Remove Equal Frames check 
box in the lower part of the IMSI Capture dialog (accessed by clicking the Options button. ). When this option is selected, only 
frames that have changed from the previous frame are included in the AVI file. This reduces the size of the AVI file without 
affecting the appearance of the animation



Creating an AVI File from an Area
This method allows you to outline the area that you want to capture. You can specify one of four shapes for the capture area—
rectangle, ellipse, freeshape, and star. After you initiate the capture, the cursor becomes a scissors icon and you can click and 
drag to define the area to capture. The image within the area that you define is repeatedly captured until the maximum number of
files is reached or you stop the capture.

To capture motion within an area that you specify
1 In the Capture Method box , select one of the following options:

Area-Rect, to capture a rectangular area of the screen
Area-Ellipse, to capture an elliptical area of the screen
Area-Freeshape, to capture an area defined by a freehand line that you draw
Area-Star, to capture an area within a star shape.

2 Click the Minimize button in the top right corner of the IMSI Capture Setup dialog. IMSI Capture is minimized and shown as an
icon on the Windows Taskbar.

3 When the starting image you want to capture is displayed on your screen, press the hotkey combination specified in the IMSI 
Capture Setup dialog (Ctrl+Shift+C by default).

4 The cursor changes to a scissors icon and you can click and drag to define the area to be included in the capture. The area 
you defined is captured at the Frame Rate you specified in the IMSI Capture Setup dialog and used to generate an AVI file.

Note

You can choose to remove consecutive frames in which the image is the same by selecting the Remove Equal Frames check 
box in the lower part of the IMSI Capture dialog (accessed by clicking the Options button. ). When this option is selected, only 
frames that have changed from the previous frame are included in the AVI file. This reduces the size of the AVI file without 
affecting the appearance of the animation



Capturing a web site
IMSI Capture allows you to capture web sites. You set the number of levels of hyperlinks you want to download and use the 
filters to exclude certain types of information. IMSI Capture places the contents of a web site on your computer.

To capture a web site
1 In the IMSI Capture Setup dialog, select the Web button. 

2 In the Name box, type a name to assign to the web site when it is downloaded to your computer. This name only identifies the 
web site on your computer. If you have captured the site before, click the down arrow to select the name from a list.

3 In the Location box, type a path for the location on your computer where you want to download the web site. If you don't know 
the path, click the Browse button to find the location where you want to store the downloaded files.

4 In the Start URL box, type the URL address of the Web site where you want the capture to start.

5 Set any of the other options in the IMSI Capture Setup dialog. For information about the setup options, use context-sensitive 
help,, or see Settings for Web Capture 

6 Start the web capture by pressing the hotkeys , or by clicking the Capture Now button. 

For more information see the following topics:
 Setting the Link Depth
 Applying Filters to the Web Capture
 Specifying the Scope of the Web Capture
 Limitations of IMSI Web Capture



Setting the Link Depth
You can specify the maximum number of levels of hyperlinks that you want your web capture to include. The value in the Link 
depth box in the IMSI Capture Setup dialog determines the number of levels of hyperlinks that will be captured. A negative value 
specifies an infinite number of levels.

For example, if you enter 1 in the Link depth box, then the capture will be limited to the starting web page and pages that are 
directly linked to that web page.

To set the Link Depth
1 In the IMSI Capture Setup dialog, select the Web button. 

2 In the Link Depth box, specify the number of levels of hyperlinks you want to include in your capture. A negative value 
specifies an unlimited number of levels.



Applying Filters to a Web Capture
When you perform a web capture you can control the resources that are captured by using filters to exclude certain types of 
resources. The Filters section of the IMSI Capture Setup allows you to apply the following types of filters:

Media Type 

URL 

Context 

To apply filters to a web capture
1 In the IMSI Capture Setup dialog, select the Web button. 

2 In the Filters section, select the check box for each type of filter you want to apply.

3 To change the settings for a filter type, double-click on the filter type.



Specifying the Scope of the Web Capture
The IMSI Capture Setup dialog provides three options for defining the scope of a web capture:

Unlimited 

Start Website 

Start Directory 



Using the IMSI Capture Control Center
The IMSI Capture Control Center loads on startup if the Load on Startup check box in the options section of the IMSI Capture 
Setup dialog is selected.

As long as the Control Center is running, you can start a capture by pressing the hotkeys or by opening the Control Center and 
clicking the Start button.

The Control Center is minimized to an icon (shown below) at the far right side of your Windows Taskbar.

The Control Center allows you to start IMSI Capture without first opening the program. When you open the Control Center, 
information about the current settings in the IMSI Capture Setup dialog is displayed. You can start a capture by clicking the Start 
button in the Control Center or by pressing the hotkeys. .

To create a capture using the IMSI Capture Control Center.

1 In the Windows Taskbar, click the IMSI Capture Control Center icon  .
If the icon is not displayed, you can display it by clicking The Windows Start button, then selecting Programs, IMSI Capture, 
IMSI Capture Control Center.

2 The IMSI Capture Status dialog is displayed, showing information on the current capture settings. To start the Capture, 
click the Start button.

To create a capture without opening the Control Center
If you know that the current capture settings are appropriate for the capture you want to perform, click the hotkeys to start the 
capture. As long as the Control Center is running the hotkey combination will start the capture.

Note

· If you want to change the capture settings, right-click on the IMSI Capture Control Center icon, and from the pop-up menu, 
select the type of capture you want to perform. The IMSI Capture Setup dialog opens and you can change the Capture 
settings.



Technical Support
Free unlimited technical support is available online at http:www.imsisoft.com/support.    This support area offers access to the 
HiJaak Community, Frequently Asked Questions, Downloads and Patches, Knowledge Base, and upgrade information.    Paid 
phone technical support is also available and email support is free for a limited time. 

Technical Support hours are 7am-3pm Mountain Time, Monday through Friday, excluding holidays.    

If you are having problems with your software and cannot resolve the answer online, please let us know. Here's how to reach us:

Paid Phone Support: (505) 294-5409

Email address: supportjb@uswest.net 

World Wide Web: http://www.imsisoft.com/support 

Our support policies and procedures are reviewed regularly and are subject to change at any time.    If you have difficulties 
reaching technical support, please check our HiJaak product website for the most up-to-date policy and    contact information.



Limitations of IMSI Web Capture

Capturing interactive web pages
IMSI Web Capture is designed to perform automatic downloads of Internet resources. Once you define and start a capture, you 
can't interfere with the program's communication with the Internet. Therefore, IMSI Web Capture can't process Internet resources
that require user input, such as HTML forms. For the same reason the program doesn't pass any additional parameters on to 
CGI-scripts, ISAPI servers, etc. Found URLs that contain such parameters (after a question mark '?') are ignored. This may 
cause differences between the actual Internet site and the captured version on your hard disk. Moreover, we aware of a cases of
prematurely termination of capture on web server error, while standard Internet browsers, such as MS Internet Explorer, render 
satisfactory web page with the same URL. The cause is that having received specific error code from the web server the smart 
Internet browser automatically appends URL with additional parameters and repeats a call to the Internet. This technique lies 
beyond the capability of the current IMSI Web Capture program.

HTML parser
IMSI Web Capture includes an internal HTML parser. This parser retrieves references to other Internet resources from the 
captured HTML page. Since HTML is a rapidly developing language, not all of the HTML tags can be found and parsed by the 
present version of the parser. Thus, JavaScript tags are ignored. The list of supported HTML tags will be expanded in future 
versions of IMSI Web Capture.

Browsing in off-line mode
When IMSI Capture downloads HTML resources from the Internet, it performs automatic patching of captured resources on the 
user's hard disk. The program replaces all found references to other Internet resources so that they point to the local capture 
rather than to the Internet. This makes it possible to browse patched captures in off-line mode with the standard browser, e.g. 
MS Internet Explorer. Depending on your capture settings the program might not be able to patch each URL in the captured 
HTML document (for example, when a URL points beyond the scope of the capture as defined in the IMSI Capture Setup dialog).
Those URLs still refer to the Internet and on-line mode is required to browse such a capture.

Viewing a capture that includes multiple sites
If the you specify an unlimited WWW scope for the capture, the capture may contain local copies of several web sites. Even 
though some of them contain captured HTML pages, it's now impossible in general to run a preview of such a site directly. You 
always must start a preview of a capture with the local copy of its start URL. Then you may reach the local copy of the site you 
want by moving through the hyperlinks.

Viewing a capture that doesn't include a local copy of the start URL
In some cases a capture may not include a copy of the start URL on the user's hard disk. This might happen if the start URL for 
the start page is excluded because of a filter settings. There is no way to browse such a capture.

Moving a web capture
Once a capture has been downloaded from the Internet it can't be simply copied or moved to another location. When you move a
web capture from one folder to another the hyperlinks won't work. The hyperlinks will still point to the original location on your 
hard drive.



Using Context-Sensitive Help

Context-sensitive Help provides information on the items in dialog boxes. You can access this type of help by selecting the item 
on which you want help and pressing F1. For some items you can also access help by right-clicking on the item and from the 
pop-up menu selecting What's This?



Minimize button
 Use this button to minimize the IMSI Capture Setup dialog box without closing it.



Single Frame

When you initiate a capture, a single image is captured using the settings specified in the IMSI Capture Setup dialog.



Automatic Capture

When you initiate a capture, an image is captured automatically at the time interval you specified in the IMSI Capture Setup 
dialog. Captures will continue to be created at the specified interval until you cancel the capture command (with the same hotkey
combination used to start a capture), or the maximum number of files you specified is reached.



Motion capture

A series of images is captured and stored in a single Video for Windows (AVI) file. You can specify the number of frames per 
second to control the smoothness and size of the AVI file.



Web capture

The contents of a web site are downloaded to a specified location on your computer. You can specify the number of levels of 
hyperlinks that are to be downloaded.



Capture now

This button begins the capture. It does the same thing as pressing the hotkey combination. When a series of captures are 
occurring, such as when Automatic Capture or Motion Capture is selected, this button will stop the capture.



Close

Closes the IMSI Capture Setup dialog.



Options

The Options button extends the IMSI Capture Setup dialog to include advanced options. Click the Options button again to close 
the Advanced Options part of the dialog.



Show cursor

Select this option if you want the cursor to be shown in the captured image.



Border

Select this option if you want a thin black border to be drawn around captured images.



Grayscale

Select this option if you want captured images to be converted to grayscale.



Audible alert when capture started

Select this option if you want a sound to notify you that a capture has started.



Audible alert when capture finished

Select this option if you want a sound to notify you that a capture has finished.



Audible alert, timer before capture

Select this option if you want a sound to notify you that the timer has started to count the delay specified in the Delay box

.



Skip existing files

Select this option if you want existing files to be skipped during an automatic capture. For example, if there is an existing file 
named imsi_03.bmp and you start an automatic capture at imsi_01.bmp, then files will be saved as imsi_01, imsi_02, then 
imsi_04. The existing file is not overwritten.



Overwrite existing files

Select this option if you want existing files to be overwritten without notification.



Query

Select this option if you want a message box to ask you whether to overwrite an existing file.



AutoScroll

This option is available only for a Single Image capture using the Window capture method. Select it if you want the capture to 
scroll vertically when the window's vertical size is greater than the size of the screen. The capture will include parts of the window
that are not visible on the screen.



Annotation

This option is available only for a Single Image capture. Select it if you want to add a note to a captured image. When you 
capture an image, a dialog box is displayed that allows you to type a note and have it attached to the bottom of the image, or 
saved in a separate text file. You can also choose to automatically add a date and time stamp to the note.

You can also add annotations to files saved using the Automatic Capture method. To do this, you must capture the images and 
open them in IMSI Capture PreView. Then from the View menu, select Annotation.



Remove equal frames

This option is available only for Automatic and Motion captures. Select it if you want equal successive frames to be skipped. For 
example, if you are using automatic capture and the screen does not change during an interval, then a new capture of the screen
will not be saved until the screen changes.



Preview

Select this option if you want the last successful capture to be displayed in IMSI Capture Image Preview.    From the Preview 
application, you can also add Text, Ellipse, Rectangle or Polyline layers to your captured image.

Adding Text To Your Captured Image.    Select Tools > Text and a text box crosshair appears.    Simply draw a box where you 
want the text by clicking and holding down the left mouse button at the top left of the area and and drag the box to the bottom left
corner.    Releasing the mouse button will produce a dialog box where you will add the text message you want to display.    
Change the appearance of the text by using the right-click menu on the text box and selecting properties.    To increase or 
decrease the size of the text box, click on a corner of the text box and drag the arrow in the direction you want to go.    You can 
also position the text box layer using the options on the right-click menu.

Adding an Ellipse or Rectangle.    These options are also found under the Tools menu.    When selected, a crosshair appears.    
Simply draw a box where you want the shape by clicking and holding down the left mouse button at the top left of the area and 
and drag the box to the bottom left corner.    Releasing the mouse button will produce the new shape inside a box.    Change the 
appearance of the shape by using the right-click menu on the text box and selecting properties.    To increase or decrease the 
size of the text box, click on a corner of the text box and drag the arrow in the direction you want to go.    You can also position 
the text box layer using the options on the right-click menu.

Adding a Polyline Shape.    This option is also found under the Tools menu.    When selected, a crosshair appears.    Simply 
click with the left mouse button where you want the shape to start and release, then move to the next point of your shape and 
left-click.    Continue this procedure until you have the shape you want.    When you are completed, right-click the mouse and the 
shape will appear.    Each point that you added to the shape can be moved to a different location after you complete your shape 
by clicking on a single point and dragging it to a new location.    Change the appearance of the shape by using the right-click 
menu on the text box and selecting properties.    To increase or decrease the size of the text box, click on a corner of the text box
and drag the arrow in the direction you want to go.    You can also position the text box layer using the options on the right-click 
menu.



Load IMSI Capture Control Center on startup

Select this option if you want IMSI Capture Control Center to be loaded automatically when you start your computer.



Capture Method

Use this drop-down list to select one of the following capture methods:

· Screen -- the entire screen is captured.

· Window – you are prompted to point to the window you want to capture. Available Windows are highlighted and you click the 
one you want to capture.

· Area-Rect -- drag a rectangular box around the area you want to capture.

· Area-Ellipse -- drag an ellipse around the area you want to capture.

· Area-Freeshape – draw a freehand shape around the area you want to capture.

· Area-Star – draw a star shape around the area you want to capture.



Hotkey combination

The Hotkey combination by which the capture can be started and stopped. The default hotkeys are Ctrl+Shift+C.The prefix 
'Ctrl+Shift' is fixed so only the third symbol can be changed. Pick hotkeys that won’t conflict with any other shortcuts or hotkeys 
that you use. 



Delay

If the Image, Auto, or Motion button is selected, this box specifies the number of seconds IMSI Capture will wait before starting 
the capture after you initiate the capture.

If the Web button is selected, this box specifies the number of hours IMSI Capture will wait before starting the web capture after 
you initiate the capture.



File

Select this option if you want the captured image to be saved to a file. If this option is selected you can specify a name, type, and
location for the file, and whether you want a suffix automatically added to the file name.



Clipboard

Select this option if you want a captured image to be sent to the Windows Clipboard. From the Clipboard the image can be 
inserted into other applications using the Paste command.



Printer

Select this option if you want the captured image to be sent to your printer. When you capture an image, the print dialog box 
opens where you can set print options before sending the image to the printer.



Manual

Select this option if you want to manually enter a name for each capture. The captured file is given the name specified in File 
name box.



Automatic

Select this option if you want consecutive numeric suffixes added to the file names for each image you capture. For example, if 
you enter "imsi" in the File name box, then capture files will be named imsi_0000, imsi_0001, imsi_0002, and so on.



File type

Select the file format in which captures will be saved.



Browse

Search your system for a location and/or file name.



Compress path

Compress a long file path to make the filename visible



File name / File prefix

Use this box to enter the location and file name for the capture. It is not necessary to add an extension to the file name. The file 
extension is added depending on your selection in the File Type box. If you selected Automatic file selection, then enter the 
location and the first part of the file name. The suffix and extension are added automatically.



Hours

Select the number of hours for the Auto Capture interval.



Minutes

Select the number of minutes for the Auto Capture interval.



Seconds

Select the number of seconds for the Auto Capture interval.



Maximum number of files

Select the maximum number of files that can be generated with the current prefix when Automatic Capture is selected. When the
maximum number of files is reached, a message will notify you.



File prefix

The first part of the filename to which the suffix is added.



Frame Rate

The maximum rate in frames per second at which images will be captured. The real rate may be lower depending on system 
capabilities.



Max. time

The maximum time for which the Motion capture will continue. If this parameter is not zero the Motion Capture will be canceled 
after a specified period (in seconds).



Max size

The maximum size that the AVI file can reach before the capture is terminated. If this parameter is not zero, the Motion Capture 
will be canceled when the size (in megabytes) of the AVI file reaches this value. This value only applies to an uncompressed file. 
If you use compression, the file size will be evaluated approximately.



Use compression

Select this option if you want to compression to be applied when the AVI file is generated.



Setup

Use this option to specify and adjust the settings for the compressor that will be used when generating the AVI file. If you are 
creating a file to distribute to others, keep in mind that to view compressed files on a system, the same compressor used to 
generate the file must be installed.



Start URL

Enter the internet address (URL), from which the capture will begin.



Show sites

Click this to show web sites in the chosen capture.



Link depth

Enter the maximum number of levels of hyperlinks for the capture. A negative value means an unlimited depth.



Filters

Use this section to set filters that you want to apply to your capture. To enable a filter select the check box. To change the 
settings for a filter, double-click on the filter name.



Unlimited

Capture resources from the entire WWW.



Start web site

Capture resources from the start web site only and any pages that are directly linked to the start web site. The capture will 
include only files from the start web site and the direct links to resources on other sites. It won't include pages linked to those 
other sites.



Start directory

Capture resources from the start directory only and any pages that are directly linked to the start directory. The capture will 
include only files from the start directory and the direct links to resources on other directories. It won't include pages linked to 
those other resources.



Delete Web Capture

Delete the selected Web Capture Name from the database.



Capture Name

Enter a name for the Web capture or select it from the list.



Capture location

Specify a location for the capture.



Filter settings - Media Types

The Media Types filter allows you to specify which types of resources will be included in a web capture. 

To specify the media types to include in a capture
1 In the IMSI Capture Setup dialog, make sure the Web button. is selected.

2 In the Filters section, place a check mark in the Media Type check box.

3 Double-click on the Media Type check box to display filters settings.

4 If you want to capture all types of media, select one, several, or all of the check boxes. The media types in this filter include:
Text 
Image 
Video 
Audio 
Binary 

5 After you have selected the media types to include, click OK to apply your settings.

Note

· If the start URL specified for the capture is an HTML document, and you have the "Text" check box cleared, you won't be able 
to browse capture from "Show Sites" dialog because the filter eliminates start URL from capture.



Filter settings - URL

The URL filter includes or excludes web sites based on their URL (Internet address). In the Filter Settings - URL of WWW sites 
dialog there are two edit boxes that determine the URLs to be included in or excluded from the capture. In the first edit box you 
can enter tokens (words or parts of words) that must be included in a URL for that web site to be downloaded. In the second edit 
box you can enter tokens that must be excluded from a URL for the web site to be downloaded. You may enter one or more 
tokens in each box. Multiple tokens must be separated by a space.

To apply the URL filter
1 In the IMSI Capture Setup dialog, make sure the Web button. is selected.

2 In the Filters section, place a check mark in the URL check box.

3 Double-click on the URL check box to display filters settings.

4 In the first edit box, type the tokens (words or parts of words) that a URL must contain to be included in the capture. You can 
use multiple tokens separated by a space. When you use multiple tokens it means that a URL must contain at least one of the 
tokens to be included.

5 In the second edit box, type the tokens that a URL must not contain.

Note

· If the Match whole words only check box is selected, then only whole words that match the token are included. For example, if
you enter the token soft in the first edit box and select the Match whole words only check box, then the site 
www.mega.soft.com would be included but the site www.microsoft.com would not. Words in URLs are separated by periods.



Filter settings - Context

The Context filter includes or excludes text from the contents of web pages.    In the Filter Settings - Contents of text resources 
sites dialog there are two edit boxes that determine the text to be included in or excluded from the capture. In the first edit box 
you can enter tokens (words or parts of words) that must be included in the content for that page to be included in the capture. In
the second edit box you can enter tokens that must be excluded from the content for that page to be included in the capture. You
may enter one or more tokens in each box. Multiple tokens must be separated by a space.

To apply the URL filter
1 In the IMSI Capture Setup dialog, make sure the Web button. is selected.

2 In the Filters section, place a check mark in the URL check box.

3 Double-click on the URL check box to display filters settings.

4 In the first edit box, type the tokens (words or parts of words) that a URL must contain to be included in the capture. You can 
use multiple tokens separated by a space. When you use multiple tokens it means that a URL must contain at least one of the 
tokens to be included.

5 In the second edit box, type the tokens that the text contents of a page must not contain if it is to be included in the capture.

Note

· If the Match whole words only check box is selected, then only whole words that match the token are included.

· If the Match case check box is selected, then only text that has the same combination of upper and lower case letters are 
included or excluded by the filter.



Text media type
This media type includes all text files. These files are defined as the Text    MIME type.



Image media type
This media type includes    image files such as gif, jpeg, and tiff files that are included in the Image MIME type.



Video media type
This media type includes video files such as mpeg and Quicktime files.



Audio media type
This type of media includes audio files such as wav and midi files.



Binary media type
This media type includes files included in the Application MIME type. Some files formats included in this type include zip, pdf, 
and postscript files.



Viewing a Captured Web Site
After you capture a Web site to your computer, you can view the site without being connected to the Internet. The root folder for 
your capture contains a file called Startbrowse.htm from which you can start browsing. Each Web site in your capture is in a 
separate folder that contains a file called Index.htm. If you want to browse through pages in a specific web site, start from the file 
Index.htm for that web site.

To View a Captured Web Site
1 Using Windows Explorer or My Computer, locate the directory in which you saved the web capture. The location was specified

in the IMSI Capture Setup dialog when you performed the capture.

2 Do one of the following:

· If you want to view the captured web site from the start page, double-click Startbrowse.htm.

· If you want to start browsing from a specific Web site within the capture, locate the folder for that web site. Within the folder 
double-click Index.htm.






